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• Safety precautions 
Before you use the printer, carefully read the User’s Manual to ensure that you use the printer 
correctly.  Be aware that the content complies with the standards at the time the User’s Manual 
section related to safety, including usage and safety precautions, was created. 

• Modifications 
For product safety, it is prohibited to modify the CY printer, CY printer driver, and CD contents. 

• Copyright 
The copyrights, trademark rights, and other intellectual property rights related to documents and 
programs included with this product are the property of CITIZEN SYSTEMS JAPAN CO., LTD. and other 
rights holders.  
You cannot copy and use these items without the permission of CITIZEN SYSTEMS JAPAN CO., LTD. 
except where permitted by applicable laws. 
Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the 
United States and in other countries. 
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Chapter 1 Installation 
Installation procedure 
The installation procedure is made up of three steps. 
The details of each step are explained below. 

 

 

 

 

 

 

Step 1 Prepare the printer and computer → “1.1 Prepare the printer and computer” 

At this point, the USB cable is not yet 
connected. 

Step 2 Install the driver package → “1.2 Install the driver package” 

Insert the included CD into the disk drive, and 
then install the driver package. 

Step 3 Install the printer driver → “1.3 Install the printer driver” 

Connect the USB cable, switch on the printer, and 
then install the printer driver. 
After installation is complete, restart the computer. 

USB Cable 
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1.1 Prepare the printer and computer 
Make sure that the printer power is off. 
Prepare a USB cable.  However, do not use the USB cable to connect the printer and computer at this time. 
Log in to Windows as an administrator.  The following explanation presumes that the operations are carried 
out with administrator privileges. 

CAUTION: 
The display settings of the computer must be set as follows.  If the settings differ from the following, the 
printing preferences screen and other items may not fit in the display area. 

Resolution: At least 1280x800 
Size of text and other items (DPI): 100% 

1.2 Install the driver package 
Insert the included CD into the disc drive. 
Open Windows Explorer, and then click the corresponding drive. 
If AutoPlay is enabled, a message appears stating “Tap to choose what happens with this disk”.  Click the 
message and select “Open folder to view files Windows Explorer”. 
If AutoPlay is enabled in Windows 7, select “Open folder to view files using Windows Explorer”. 
If AutoPlay is enabled in Windows 8, a message appears stating “Tap to choose what happens with this 
disk”.  Click the message and select “Open folder to view files Windows Explorer” 
Select one of the following folders on the included CD. 

• Windows 7 ············ CD drive:\CY_Driver\English\7 
• Windows 8/10 ····· CD drive:\CY_Driver\English\8_10 

 

Figure 1.2.1 Driver Package folder 
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In the selected folder, double click the following file: DriverInstall.CMD.  (Depending on your usage 
environment, the .CMD extension may not be displayed.) 
The driver package installer appropriate for your operating system (32-bit or 64-bit) is selected 
automatically. 

 

Figure 1.2.2 Installation file 

When a User Account Control dialog box appears, click “Yes”. 

 

Figure 1.2.3 User Account Control 

Click “Next >” when the Device Driver Installation Wizard screen appears. 

 

Figure 1.2.4 Installation Wizard start screen 
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Click “Install” when the Windows Security confirmation display appears. 

 

Figure 1.2.5 Windows Security confirmation 

Installation of the driver package starts.  Wait until installation finishes. 
Click “Finish” when the Device Driver Installation Wizard completion screen appears. 

 

Figure 1.2.6 Finish of Installation Wizard 
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1.3 Install the printer driver 
Use the USB cable to connect the printer and computer, and then switch on the power of the printer. 
After the printer is recognized, installation of the driver starts. 
*For the connection, see the User’s Manual of the printer. 

In Windows 7, if driver installation starts, the following message appears in the taskbar: “Installing device 
driver software”. 
In Windows 8 and 10, this message does not appear.  Proceed to page 7. 

 

Figure 1.3.1 Driver installation message 

If you click on this message, the Driver Software Installation screen appears and displays the installation 
status of the driver.  If “Close” is clicked, this screen closes. 

 

Figure 1.3.2 Installing the driver software 

*About the “Skip obtaining driver software from Windows Update” option 
If your operating system is configured to obtain driver software from Windows Update, it may take time for 
installation to complete because the process searches for drivers from Windows Update first.  You can 
reduce the time until the completion of installation by choosing to skip obtaining driver software from 
Windows Update.  (Depending on your operating system, it may take some time until installation is 
complete.) 
From the Driver Software Installation dialog box, click “Skip obtaining driver software from Windows 
Update”. 

 

Figure 1.3.3 Option to skip obtaining driver software from Windows Update 
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A confirmation dialog box appears.  Click “Yes”. 

 

Figure 1.3.4 Confirmation to skip getting driver software from Windows Update 

Soon after installation starts, a message appears in the taskbar stating “Your device is ready to use”, and 
then printer driver installation finishes. 

 

Figure 1.3.5 Installation complete message 

If you click on the message, the Driver Software Installation dialog appears, and the “Your device is ready to 
use” message appears.  Click “Close”. 
(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar 
message is not displayed.) 

 

Figure 1.3.6 Completion of driver software installation 
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Click “Start”, and then click “Windows System” -> “Control Panel” to open the Control Panel. 
In Windows 7, click “Start”, and then click “Control Panel” to open the Control Panel. 
In Windows 8, right click the “Start” screen.  In the bottom right area, select “All Apps”, and then select 
“Control Panel”. 
In Control Panel, click “View devices and printers”. 

 

Figure 1.3.7 Control Panel 

In Devices and Printers, make sure that “CY” is present. 

Note: In Windows 8 and 10, when the printer is offline (the printer is not on and connected), “CY” icon is not 
displayed. 

This completes installation of the CY printer driver. 

 

Figure 1.3.8 Devices and Printers screen 

After the installation of the printer driver is complete, always restart the computer. 
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In Windows 7, when it was not possible to install the printer driver correctly, the following message appears 
in the taskbar: “Device driver software was not successfully installed”. 

 

Figure 1.3.9 Message indicating that the driver was not installed 

If you click on this message, the Install driver software screen appears and displays the message “Device 
driver software was not successfully installed”.  Click “Close”. 
(If the Driver Software Installation screen is open when installation starts, the abovementioned taskbar 
message is not displayed.) 
When the driver could not be installed correctly, see the next section, “1.4 Install drivers for unspecified 
devices”, and then install the printer driver. 

  

Figure 1.3.10 When the driver was not installed correctly 
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1.4 Install drivers for unspecified devices 
If you connect a printer that is on to the computer before installing the driver package, a device is created 
under “Unspecified” in Devices and Printers. 

 

Figure 1.4.1 Photo Printer under Unspecified 

In such a case, use the following method to install the printer driver. 
Furthermore, use the following method to install the printer driver if you use the standard installation 
procedure (install the driver package, connect the printer, and then install the printer driver), but the driver 
is not installed correctly, and a device is created under “Unspecified”. 

1. Install the driver package 
When the driver package has not yet been installed, install it by following the procedure in “1.2 Install 
the driver package”. 
If you install the driver package, installation of the printer driver for the unspecified device completes it 
automatically. 

2. Installing a driver for an unspecified device 
After installing the driver package, the driver installation procedure for an “Unspecified” device is 
different for Windows 7 and Windows 8,10. 
For Windows 8, 10, refer to page 10. 
For Windows 7, refer to page 11. 
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In Windows 8,10: 

1) Right-click “Photo Printer” of the “Unspecified” device in “Devices and Printers”, and click “Remove 
device” from the pull-down menu. 

 

Figure 1.4.2 Delete “Photo Printer” 

2) Disconnect the USB cable connected to the printer. 

3) Restart your computer. 

4) After starting up the computer, connect the USB cable again and turn on the printer. 

In Devices and Printers, make sure that “CY” is present. 

Note: When the printer is offline (the printer is not on and connected), the “CY” icon is not displayed. 

This completes installation of the printer driver. 

 

Figure 1.4.3 Devices and Printers screen 

After the installation of the printer driver is complete, always restart the computer. 
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In Windows 7: 
In “Devices and Printers”, under “Unspecified”, right click on “Photo Printer”.  From the menu, click 
“Troubleshoot”. 

 

Figure 1.4.4 Photo Printer under Unspecified 

The Install a driver for this device screen appears.  Click “Apply this fix”. 
The computer searches for a driver automatically, and then installs it. 

 

Figure 1.4.5 Applying a fix 
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If the driver is installed, the message “Troubleshooting has completed” appears.  Click “Close the 
troubleshooter” to close the troubleshooting window. 

 

Figure 1.4.6 Completing troubleshooting 

In Devices and Printers, make sure that “CY” is present. 
This completes installation of the printer driver. 

 

Figure 1.4.7 Devices and Printers screen 

After the installation of the printer driver is complete, always restart the computer. 
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Chapter 2 Properties 
You can configure various printer settings from the Properties of the driver.  Make sure you understand the 
contents well before changing settings.  To use the properties, log in as an administrator.  Depending on 
the application you are using, you must perform this operation from the print settings of the application. 

2.1 Open the printer properties 
1. Click the “Start”, click “Windows System”,and then click “Control Panel” to open the Control Panel. 
 In Windows 7, Click “Start”, and then click “Control Panel” to open the Control Panel. 
 In Windows 8, right click the “Start” screen, click “All Apps”, and then click “Control Panel” to open the 

“Control Panel”. 

 

2. From the Control Panel, click “View devices and printers” to open the Devices and Printers screen. 
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3. Right click “CY” icon.  From the menu, click “Printer Properties”to open the Properties dialog box. 
 Note: In Windows 8 and 10, when the printer is offline (the printer is not on and connected), “CY” icon is 

not displayed. 

 

4. CY Properties screen appears. 
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2.2 Print settings functions 
If you select the basic settings from the Properties screen, you can change various print settings. 

2.2.1 Layout 

 
Figure 2.2.1 Layout tab 

Orientation 
Set the print orientation to “Portrait” or “Landscape”. 
For details, refer to “2.6 Orientation”. 

Page Order 
In the application, specify the order when multiple copies of an image are printed. 
Example) Print order

 

Page Format 

Pages per Sheet 
Set printing of the specified division size.  In most situations, set “1”. 
(If you want to specify other than 1, please use the Print Quality settings to 300x300dpi or 
600x600dpi) 
Example) Division size  

No.1 No.2 No.3 

Front to Back 

Back to Front  

1 division 4 divisions 9 divisions 
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2.2.2 Advanced options 
If you select “Advanced...” on the Layout tab, you can configure various advanced options. 

  
Figure 2.2.2.1 Advanced settings Figure 2.2.2.2 Advanced options tab 

Paper/Output 

Paper Size 
Specify the paper size.  Match the paper size with the size of the media set in the printer. 
You can enable multiple layout settings by setting the paper size.  See later sections for details. 

Copy Count 
You can specify the number of copies to be published for images. 
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Graphic 

Print Quality 
Specify the resolution. 

Print quality Function 
300 x 300dpi Printing in the high-speed mode 
300 x 600dpi Printing in the high-quality mode 

* If the application can not set an asymmetric aspect resolution, please set the 
600x600dpi. 

* When you execute the “Print Test Page” in printer properties in Windows 8 and 
10, depending on the specifications of the OS, is printed the aspect ratio of the 
printer mark is different. 

600 x 600dpi Printing in the high-quality mode  
(Printer driver converts to 300x600dpi data, and sends it to the printer.) 

ICM Method 
ICM Method Function 

ICM Disabled Synchronized with “Color Adjustment Disabled” in the 2.2.4 Option. 
ICM Handled by Host 
System 

Synchronized with “Color Adjustment ICM” in the 2.2.4 Option. 
Manage colors using the driver. 

ICM Handled by Printer When this item has been selected, operation is the same as “ICM 
Handled by Host System”. 

ICM Intent 
Set the rendering method when using ICM.  For the ICC profile, always set to “Pictures”. 
Do not use other settings. 

Document Options 

Advanced Printing Features 
Always set “Enabled”.  Do not use other settings. 

Pages per Sheet Layout 
Set the layout direction of an image when the Pages per Sheet setting is set for multiple divisions. 

Printer Features 

Border 
Synchronized with Border in the Option. 

Overcoat Finish 
Set the overcoat finish method for the surface of printed items from the following two types. 

Overcoat Finish Function 
Glossy Create an item with a glossy finish. 
Matte Create an item with a matte finish. 



 

18 
CITIZEN SYSTEMS JAPAN CO., LTD. 

[CY Printer Driver] Instruction Manual (For Windows 7, 8, 10) 

Print Re-try 
Specify whether to print data in the printer buffer after a printer error has been cleared. 

Print Re-try Function 
Disable Clear the print data in the printer buffer when a printer error occurs. 

You must send the cleared print data again after the error is cleared. 
When you use an application with an error recovery function, select this option. 

Enable Save print data in the printer buffer when an error occurs. 
The printing process is restarted from the saved data after the error is cleared. 
Note that if the power is switched off, the data is not saved. 

Depending on the content of the printer error, it may be necessary to restart the printer to clear the 
error.  In such cases, the print data in the printer buffer is cleared regardless of the Print Re-try 
setting. 
The following section shows the operation for each Print Re-try setting by error. 

Error content When Print Re-try is disabled When Print Re-try is enabled 
Paper end You must send the unprinted 

image data again after the 
error is cleared. 

The printing process is restarted 
from the data saved in the 
printer buffer after the error is 
cleared. 
When the paper initialization 
operation is to be carried out, 
printing occurs afterwards. 

Ribbon end 
Cover open 
Paper jam (*1) 
Ribbon error (*1) 
Paper setting error 
Data error Because the printer must be 

switched on and off to clear the 
error, the print data in the 
printer buffer is cleared 
regardless of the Print Re-try 
setting. 
After the printer has restarted, 
you must send the unprinted 
image data again. 

Because the printer must be 
switched on and off to clear the 
error, the print data in the 
printer buffer is cleared by 
switching the printer off, even 
when the Print Re-try setting is 
Enabled. 
After the printer has restarted, 
you must send the unprinted 
image data again. 

Head voltage error 
Head position error 
Power supply fan stopped 
Cutter error 
Head temperature error 
Media temperature error 
Ribbon Tension Error 
RFID module error 
System error 

*1: After the printer stops due to an error, follow the User’s Manual of the printer to eliminate the 
cause of the paper or ribbon error. 

2inch cut  
Specify whether to cut paper into multiple sheets with a 2-inch length when you use a specified 
paper size. 

2inch cut Function 

Disable Cut at the normal size. 

Enable Cut at 2-inch lengths so that the (6x4) and PR(4x6) size becomes two sheets and 
the (6x8) size becomes four sheets. 

(Depending on the version of printer firmware being used, “Disable” may be the only option.) 
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<Multiple layout> 
When the CY is using 6x8 size media, 2 image layout is possible. 
With the printer driver paper setting, multi-image layout is made possible, and the image sizes are as 
follows. 

Layout settings 

Driver paper size setting Paper direction Paper size 
length x height (mm) Media used 

(6x4) x 2 Portrait (156.1x105.0) x 2 6x8 
Landscape (105.0x156.1) x 2 

PR (4x6) x 2 Portrait (105.0x156.1) x 2 6x8 
Landscape (156.1x105.0) x 2 

Image layout median size 2.54  
Multiple layout is possible under the following conditions. 

1. The printer is using 6x8 size media. 
2. The printer driver paper size is set to one of the above sizes. 
3. Multiple images are sent from the application. 

Note) Because the multi-image layout occurs on a per job basis, this works when there  
are multiple images for 1 job.  If you want to print the same image, be sure to send the image 
data for each copy to be printed.  The printer prints 2 images in one operation, and the paper is 
cut as it is fed out. 

 

Same-size images on one sheet 
Layout of 2 pictures: set x 2 Cut when paper is ejected 
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<Application usage example> 
This usage example uses Windows Explorer. 

Step 1. In Windows Explorer, select two or more 
pictures. 
Next, click “Print”. 

 

Step 2. Select “Fit picture to frame” check box, 
and then click “Options...”. 

 

Step 3. Click “Printer Properties...”. 

 

Step 4. Set the Orientation to “Portrait”, and click 
“Advanced...”. 

 

Step 5. Set the Paper Size to “(6x4)x2”. 
Click “OK” twice to close the dialog boxes 
in Step 5 and 4. 

 

Step 6. Click the “Print” button. 

 

Select 2 or 
more images 
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2.2.3 Paper/Quality 

 
Figure 2.2.3 Paper/Quality tab 

Color 
Set Color.  Do not use black and white. 

2.2.4 Option 

  
Figure 2.2.4.1 Option tab Figure 2.2.4.2 Sharpness setting 

Border 
Specify a border for printing.  (Select the check box for a border.) Synchronized with Border Enable / 
Disable in the Advanced settings. 

Sharpness 
Process sharpness using one of the 11 stages (Figure 2.2.4.2).  If the setting is “0 (Default)”, 
sharpness is not processed. 
Moving to the minus (-) side blurs the image and moving to the plus (+) side sharpens the image. 
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Color Adjustment 

None 
Synchronized with the ICM Method in the Advanced settings.  If this check box is selected, ICM is 
disabled, the Color adjustment tab is also disabled, and the printer driver does not carry out 
color adjustment. 

Handled by Driver 
If this check box is selected, ICM is disabled, and the 2.2.5 Color Adjustment is enabled.  
The result is applied to the adjustment values of the following items: Gamma, Brightness, 
Contrast, and Chroma. 

ICM 
Synchronized with the ICM Method of the Advanced settings (ICM Handled by Host System).  
If this check box is selected, the driver manages colors. 

ICM & Driver 
If this check box is selected, ICM (color management) and the 2.2.5 Color Adjustment are 
enabled. 

About 
Show the driver version. 
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2.2.5 Color Adjustment 
If the Handled by Driver check box is selected in the 2.2.4 Option, the adjustment values of the Color 
Adjustment tab are applied to the image. 

 
Figure 2.2.5 Color Adjustment tab 

The following section shows the setting ranges on the Color Adjustment tab. 
Adjustment item Adjustment value 

Gamma -100 (dark) to 100 (bright) (“0” results in no adjustment, γ2.0 to 0.5) 
Adjust the density of the half-tone section of the image.  Increasing the gamma 
value brightens the half-tone section. 
Sync check box 

ON: Set RGB to same value. 
OFF: Set RGB to different value. 

Brightness -100 (dark) to 100 (bright) (“0” results in no adjustment) 
Adjust the brightness of the image.  Increasing the brightness value brightens 
the entire image. 
Sync check box 

ON: Set RGB to same value. 
OFF: Set RGB to different value. 

Contrast -100 (weak) to 100 (strong) (“0” results in no adjustment) 
Adjust the contrast of the image.  Increasing the contrast value increases the 
difference of brightness and darkness. 
Sync check box 

ON: Set RGB to same value. 
OFF: Set RGB to different value. 

Chroma -100 (weak) to 100 (strong) (“0” results in no adjustment) 
Adjust the chroma of the image. 
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2.3 Default values for settings 
The following section shows the default values of the settings (at installation).  If the settings have been 
changed, and the printer driver no longer operates normally, return to the default values shown below. 

Note) Depending on the service pack of your operating system or your usage environment, the default 
values at installation may differ from those in the chart below. 

Chart 2.3 Default print settings 

Tab Setting Value 

Layout 
Orientation Portrait 
Page Order Front to Back 
Pages Per Sheet 1 

Paper/Quality Color Color 

Option 
Border Disable 
Sharpness 0 (Default) 
Color Adjustment ICM 

Color Adjustment 

Gamma 0 
Brightness 0 
Contrast 0 
Chroma 0 

Advanced settings 
(In the Layout tab, 
click “Advanced...”) 

Paper/Output 
Paper Size (6x4) 
Copy Count 1 Copy 

Graphic 

Print Quality 300x300dpi 

Image Color 
Management 

ICM Method ICM Handled by 
Host System 

ICM Intent Pictures 

Document options 

Advanced Printing Features Enabled 
Pages per Sheet Layout Right then Down 

Printer function 

Border Disable 
Overcoat Finish Glossy 
Print Re-try Disable 
2inch cut Disable 
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2.4 Color management 
Use Color management to specify the color profile.  The installer associates “CY_xxxx.icc” by default. 
xxxx indicates the version. 

Step 1. From the Printer Properties, select the Color Management tab, and then click “Color 
Management...”. 

 

Figure 2.4.1 Color Management 

Step 2. From Device, select “Printer: CY”. 

 

Figure 2.4.2 Color Management Window 

The installer associated this file 
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2.5 Print Area 
The following section shows the image sizes and numbers of dots generated by the paper size setting of 
the driver. 

Paper size Orientation 
Image size 

(width x height) 
Image pixel amount 

(width x height) 
(inch) (mm) 300x300 DPI 300x600 DPI 600x600 DPI 

(5x3.5) 
Portrait 5”x 3.5” 131.1 x 92.1 1548 x 1088 1548 x 2176 3096 x 2176 

Landscape 3.5”x 5” 92.1 x 131.1 1088 x 1548 2176 x 1548 2176 x 3096 

(6x4) 
Portrait 6”x 4” 156.1 x 105.0 1844 x 1240  1844 x 2480 3688 x 2480 

Landscape 4”x 6” 105.0 x 156.1 1240 x 1844 2480 x 1844 2480 x 3688 

(5x7) 
Portrait 5”x 7” 131.1 x 181.0 1548 x 2138 1548 x 4276 3096 x 4276 

Landscape 7”x 5” 181.0 x 131.1 2138 x 1548 4276 x 1548 4276 x 3096 

(6x8) 
Portrait 6”x 8” 156.1 x 206.2 1844 x 2436 1844 x 4872 3688 x 4872 

Landscape 8”x 6” 206.2 x 156.1 2436 x 1844 4872 x 1844 4872 x 3688 

PR (3.5x5) 
Portrait 3.5”x 5” 92.1 x 131.1 1088 x 1548 2176 x 1548 2176 x 3096 

Landscape 5”x 3.5” 131.1 x 92.1 1548 x 1088 1548 x 2176 3096 x 2176 

PR (4x6) 
Portrait 4”x 6” 105.0 x 156.1 1240 x 1844 2480 x 1844 2480 x 3688 

Landscape 6”x 4” 156.1 x 105.0 1844 x 1240  1844 x 2480 3688 x 2480 



 

27 
CITIZEN SYSTEMS JAPAN CO., LTD. 

[CY Printer Driver] Instruction Manual (For Windows 7, 8, 10) 

2.6 Orientation 
The following chart shows the relationship of images generated by an application and printed items 
(output direction) according to the orientation setting. 

Hint: The PR print size (center column) is prepared for applications that are not able to change from 
landscape to portrait and back using the orientation setting on the layout tab.  Normally it is 
recommended to use the non-PR print sizes and use the orientation settings for landscape and 
portrait on the layout tab. 

Original 
image 

Driver setting 

Orientation 

Paper setting 
(5x3.5) 
(6x4) 
(6x4) x 2 

PR (3.5x5) 
PR (4x6) 
PR (4x6) x 2 

(5x7) 
(6x8) 

Generated 
image 

Printed item 
(Output 

orientation ↓) 
Generated 

image 
Printed item 

(Output 
orientation ↓) 

Generated 
image 

Printed item 
(Output 

orientation ↓) 

 

Portrait 
  

 
 

  

Landscape 

 
    

 

 

Portrait 

  
 

 
  

Landscape 
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Chapter 3 Update the driver 
As when performing the installation, log in as an administrator before carrying out this operation. 

1. Delete the driver 

1) Before deleting the printer driver, close all applications.  Furthermore, click on the icon of the printer 
to be deleted in the “Devices and Printers” screen.  At the bottom area of the screen, confirm that 
there are no documents in the queue, and then start deletion of the driver. 

Note: In Windows 8 and 10, when the printer is offline (the printer is not on and connected), the CY 
icon is not displayed.  If you cannot connect a printer that is on, use the procedure on the 
following page to delete the device. 

 

Figure 3.1 Clicking the “CY” icon at the Devices and Printers screen 

2) Click “Start”, and then click “Windows System” -> “Control Panel”.  In the Control Panel, click “View 
devices and printers”. 
In Windows 7, Click “Start”, and then click “Control Panel”.  In the Control Panel, click “View devices 
and printers”. 
In Windows 8, right click the “Start” screen.  In the bottom right area, select “All Apps”, and then 
select “Control Panel”.  In the Control Panel, click “Devices and Printers”. 
From the Devices and Printers screen, right click the CY printer.  From the menu, click “Remove 
device”. 

 

Figure 3.2 Right clicking CY in the Devices and Printers screen 
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In Windows 8 and 10, when the printer is offline (the printer is not on and connected), the CY icon is 
not displayed.  In such cases, use the following procedure to delete the device. 

(i) On an empty area in the Devices and Printers screen, right click, and then select “Device 
Manager”. 

 

Figure 3.2.i Right clicking on an empty area in the Devices and Printers screen 

(ii) Click “View”, and then select “Show hidden devices”. 

 

Figure 3.2.ii Displaying the View menu for hidden devices 

(iii) Under “Printers”, right click “CY”, and then select “Uninstall device”. 
In Windows 8, select “Uninstall”. 

  
(In Windows 8) (In Windows 10) 

Figure 3.2.iii Displaying the menu to delete CY 

(iv) At the “Uninstall Device” screen, click “Uninstall”.  
In Windows 8, At the “Confirm Device Uninstall” screen, click “OK”. 

  
(In Windows 8) (In Windows 10) 

Figure 3.2.iv Uninstall Device screen 
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3) The printer deletion confirmation dialog box appears.  Click “Yes”. 

 

Figure 3.3 Printer deletion confirmation dialog box 

4) After deleting the CY printer, select another printer (for example, Fax), and then click “Print Server 
Properties” in the menu bar. 

 

Figure 3.4 Displaying the Print Server Properties menu in the Devices and Printers screen 

5) The “Print Server Properties” dialog box appears.  Click the “Drivers” tab.  From the installed printer 
driver list, select “CY”, and then click “Remove...”. 

 

Figure 3.5 Printer Server Properties dialog box 
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6) The “Remove Driver and Package” dialog box appears.  Select “Remove driver only”, and then click 
“OK”.  To delete the driver package, carry out the procedure in the next section, “2. Uninstall the driver 
package”. 

 

Figure 3.6 Remove Driver And Package dialog box 

7) The “Print Server Properties” confirmation dialog box appears.  Click “Yes”. 

 

Figure 3.7 Driver deletion confirmation dialog box 

If the following message appears, the operating system may be using the driver (Print Spooler 
service) in the background.  Disconnect the USB cable and then restart your computer and try 
deleting the printer driver again. 

 

Figure 3.7.i Driver in use 
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8) In the “Print Server Properties” dialog box, confirm that CY was deleted, and then click “Close”.  After 
deleting the printer driver, uninstall the driver package. 

 

Figure 3.8 Print Server Properties 

2. Uninstall the driver package 

1) Click “Start”, and then click “Windows System” -> “Control Panel”.  In the Control Panel, click “Uninstall 
a program”. 
In Windows 7, click “Start”, and then click “Control Panel”.  In the Control Panel, click “Uninstall a 
program”. 
In Windows 8, right click the “Start” screen.  In the bottom right area, select “All Apps”, and then 
select “Control Panel”.  In the Control Panel, click “Uninstall a program”. 

 

Figure 3.9 Control Pannel 
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2) The “Uninstall or change a program” screen appears.  In the list, double click “Windows Driver 
Package – CITIZEN SYSTEMS CY (mm/dd/yyyy x.x.x.x)”.  (mm/dd/yyyy is the date, x.x.x.x is the 
version.) 

 

Figure 3.10 Uninstall a program 

3) The “Uninstall Driver Package” screen appears.  Click “Yes”. 
The program has been uninstalled. 
After uninstalling the printer package, restart the computer. 

 

Figure 3.11 Uninstallation confirmation 

3. Install an upgrade for the printer driver 
After deleting the printer and the printer driver, install the new printer driver.  For the installation 
procedure, see “Chapter 1 Installation”. 

4. Restart the computer 
After the installation of the printer driver is complete, always restart the computer. 
(Do not print just after installation.  Always restart the computer once.) 
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Chapter 4 Delete the driver 
For the procedure to delete the printer driver, see Chapter 3, “1. Delete the driver” and “2. Uninstall the driver 
package”. 
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